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Introduction
The Cash Counter program is a part of the Small Office Tools suite that was designed to provide specialized, easy-to-use software for a
small business office. The Cash Counter specializes in keeping the cash till of a small business in check. The Cash Counter program is
both very small in size and quite versatile in its application. Read on for details on how to use it.

 

Installation
Before you can take advantage of the Cash Counter program, you need to download it. It comes packaged in a ZIP archive. After you've
download and opened it (and passed all of the "mandatory" Windows warnings), you will see the contents of the archived package that
include a copy of this manual, a short description of the program, and the CashCounter.exe file, that is the Cash Counter itself. It has the
following icon:
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Simply drag this icon onto your desktop (or into your documents folder), and ... you're done installing the Cash Counter.

You may want to run the downloaded package through your favorite antivirus to make sure that we're honest with you.

 

Uninstallation
Well, as much as we don't want you to uninstall the Cash Counter, let me briefly explain how you can do it ;) As you could've imagined,
uninstalling it is as simple as installing it. The Cash Counter runs from a single exe file that has the icon like the one shown above in the
installation section. Simply drag this icon into your Recycle Bin, or right-click it and select Delete. After that, confirm deletion, and ...
you're done uninstalling the Cash Counter.
 
In case you want to read technical details about the data in the System Registry, etc. please refer to this FAQ.

 

Application
When you open the Cash Counter its main window will be configured depending on your location (by country) and the current user
interface for that country. For a user in the United States and for the U.S. currency, the Cash Counter's main window may look close to
this:

Note that the Cash Counter memorizes previous states of its controls so some fields may be filled out differently in your case.
 

 

Controls Layout

Cash Count Fields are located in the main area of the Cash Counter window. Their layout is dependent on the selected country
and the currency format for that country. They are broken down into currency denominations specific for the selected country
and are grouped into two columns. Denominations in the left column are intended to represent coins, and denominations in the
right column - bank notes, although this classification is not rigid and could be changed in the Preferences.
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Each denomination field consists of the following parts: 

   
 

Denomination Name on the left. It can be grayed out in case of a rare denomination. This name can be also adjusted in
the Preferences.
 
Denomination Value expressed in the amount of a single unit of currency for the selected country.
 
Text box field for the number of units of this denomination. It allows you to enter a positive number to represent the
count for that particular denomination value. You can also leave this field blank to represent zero.

To enter a count value into this text box you can left-click it with a mouse and type in the number on the keyboard. After
that you can switch to the next count field by pressing the Tab key on the keyboard (or the Enter key, if configured in the
Preferences). You can also use the Up and Down Arrows on the keyboard to navigate through the cash count fields.

While navigating through the cash count fields using the keyboard the Cash Counter will skip any unfilled rare denominations. This can be
adjusted in the Preferences.
 
Total amount for this denomination, presented after the equation sign. It indicates the monetary amount for this
particular denomination value, times the number of units.

 
Cash Drawer Amt field allows you to enter the amount that is supposed to remain in your cash drawer when it's balanced. The
calculation of the Difference and whether the cash till is balanced or not will be done against this amount.

The Cash Counter memorizes the Cash Drawer Amount so that you don't have to enter it every time.
 
Total Counted control contains the total value of currency counted in the cash count fields . This amount will change
automatically as you enter new, or edit existing cash count fields .
 
Petty Cash control contains the total value of the items entered in the Petty Cash list . This amount will change automatically as
you alter items in the Petty Cash list .

The Petty Cash amount is displayed only if every item in the Petty Cash list is represented by the currency of the country that is currently selected. If at
least one item in the Petty Cash list doesn't satisfy this condition, the Petty Cash amount is displayed as a red dash, indicating a conflict.
 
Difference control represents the variance between the Cash Drawer Amount, the Total Counted amount and the Petty Cash
amount. It is color-coded for better readability:

   

It will be displayed in red if your cash till count plus the Petty Cash amount is "under", or less than the Cash Drawer Amount. And
it will be displayed in green (in a negative currency format for the selected country) if your cash till count plus the Petty Cash
amount is "over", or greater than the Cash Drawer Amount. In case the cash till is balanced, the Difference field is displayed in
default (black) color.

The calculation of the Difference amount can be expressed by the following mathematical formula:

Difference = Cash Drawer Amount - Total Counted Amount - Petty Cash Amount

Counted By controls let you add, remove or select a person who did the cash (till) count. The result is stored in the Counted By
list :



The Counted By list entries may be also used when adding items into the Petty Cash list.

The Counted By list is initially empty, so the first time you do cash count you will need to enter a person's name who counted the
till in the text box field. (There's no restrictions on which characters you can enter, except that the person's name has to be less
than 256 characters long.) After you enter the name you can either hit Done, or click the Plus sign button on the right to make
the Cash Counter memorize this name.

You can specify in the Preferences whether it's necessary for everyone to enter their name in the Counted By control before finalizing the cash count by
pressing Done button.

The next time you do cash count, instead of typing your name, you can select it from the drop-down list of already entered
names:

In case your name isn't in the list, you can simply type it in the text box field. The Cash Counter will remember it after you finalize
the cash count by clicking Done.

You can also control names in the Counted By list by doing the following: 
 

Click the "+" button on the right to add a new name to the Counted By list . Note that the name to add to the list must
be typed in the text box field. In case such name already exists in the list, or if the text box field is empty the Cash
Counter does nothing.
 
Click the "-" button on the right to remove a name currently selected in the text box field from the Counted By list . In
case such name does not exist in the list, or if the text box field is empty the Cash Counter does nothing.

In case the name being removed is also used in one or more items in the Petty Cash list, you will see a warning, in which case the Cash Counter
will need your confirmation to remove this name from the Counted By list.
 
While deleting names from the Counted By list, the Cash Counter treats them in a case-insensitive way. This means that names such as "John
Doe" and "john doe" will be treated as the same name.

 
Petty Cash list lets you enter and later edit any purchases made from your cash till. They are generally called as petty cash items
in the Cash Counter. These items are regularly reimbursed later on and their cash value is returned to the cash till. The Petty Cash
list is displayed on the left side of the main window of the Cash Counter. It may look like this:



The Petty Cash list has the following predefined columns: 
 

Item column - contains descriptive name of a petty cash item . Try to use short names that best describe your petty cash
items.
 
Date column - contains short version of a date when a petty cash item was entered. The date is presented in the format of
the currently selected country.
 
Amt column - contains the amount of a petty cash item . Each amount is presented in the currency of the country selected
at the time when each petty cash item was entered.

Although it is possible to enter several petty cash items using currencies of two or more different countries, doing so is not recommended
because it will prevent the Cash Counter from calculating the total for the Petty Cash amount.
 
User column - (originally removed) contains the name of a person who entered a petty cash item . Entering names into this
column, as well as using it, is optional.
 

You can customize the look of the Petty Cash list: 
 

To resize columns hover the mouse cursor over the column header separator, and drag it either to the left or to the right.
The Cash Counter will memorize the Petty Cash list column layout the next time you run it.
 
To move columns drag a column header label either to the left or to the right. This will let you reposition the Petty Cash
list columns. The Cash Counter will memorize the Petty Cash list column layout the next time you run it.
 
To add or remove a certain column, either right-click on the column header and select Edit Columns, or go to
Preferences and switch to the Petty Cash tab. Use this page for further instructions.
 
To reset columns to their default look, right-click on the column header and select Reset to Defaults.

To add a new item into the Petty Cash list , either click the "+" button above it, or go to Tools -> Add Petty Cash Item in the
main menu, or press Ctrl+N on the keyboard. The Cash Counter will add a new empty item to the bottom of the Petty Cash list
and enter the editing mode, that may look like this:

Note that the date and the amount will be filled out automatically for you. The date is represented by today's date in a short
format for the selected country, and the amount will be set to zero. At this point you can begin entering your new petty cash
item .

In case you don't enter a petty cash item's  descriptive name, nor enter the name of a person in the User column, and keep its amount at 0, this item will
be automatically removed the next time you run the Cash Counter.



  
To edit an existing petty cash item , either double-click on the Petty Cash list column that you want to edit, or right-click on the
Petty Cash list column that you want to edit and select Edit , or press Enter on the keyboard while the Petty Cash list has the
keyboard focus. The Petty Cash list will enter the editing mode that may look like this:

Note that the column currently being edited is displayed with a yellow background (for our selected Windows theme).

You can edit out or adjust the currently editable column by using the keyboard. Note that the Date and the Amount columns
expect you to enter their values in a certain format, that is specific for the currently selected country.

While in the editing mode you can do one of the following: 
 

Click away somewhere on another control to accept the edit.
 
Press Enter key on the keyboard to accept the edit. (Note that pressing Enter key again will return you back into the
editing mode.)
 
Press Tab key on the keyboard to accept the edit and switch to the next editable column in the Petty Cash list .
 
Press Esc key on the keyboard to cancel the edit and return the petty cash item to its original value.

To remove one or more entries from the Petty Cash list first select them with the mouse. To select a group of items, click on the
first of them, then press and hold down the Shift key and click on the last item in the group. This should select all items in
between them. You can also press and hold down the Ctrl key while clicking on the items in the Petty Cash list to toggle their
selection.

When one or more Petty Cash list items are selected, either click the "-" button above it, or go to Tools -> Remove Petty Cash
Item(s) in the main menu, or right-click on the selection and click Remove. Before removing selected petty cash items the Cash
Counter will show a confirmation prompt.

WARNING: Removing Petty Cash list items cannot be undone or reverted!

 
Done button lets you finalize the cash count. It is located in the bottom right corner of the Cash Counter window:

You can also finalize the cash count by going to File -> Done in the main menu, or by pressing Ctrl+Enter on the keyboard.

In case all of the cash count fields are empty, clicking the Done button will make the Cash Counter simply close without doing the finalization.

If you set up the Preferences to require users to fill out the Counted By control and it is left blank when the Done button was clicked, the Cash Counter
may flash the Counted By control with red. Depending on the Preferences setting the Cash Counter may also prevent you from finalizing the cash count
without the Counted By field being filled out.

After the cash count is finalized, the Cash Counter will close automatically.
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Finalizing Cash Count

When you're done filling out the cash count fields you will need to finalize it by clicking the Done button. This will enter your cash (till)
count into the Cash Counter's database, and, if configured in Preferences, will display a printout of the Cash Counting Report, that you
may use in your financial accountability paperwork.

In case you want to print out the Cash Counting Report  for the current cash count fields without finalizing it, either go to Reports -> Cash Counting Report  in the
main menu, or press Ctrl+P on the keyboard.

The Cash Counting Report is opened using your installed web browser (in most cases it becomes the Internet Explorer). It may look like
this:

The Cashing Counting Report is laid out in the form best suitable for printing.

You may set up in Preferences whether the Cash Counter needs to automatically open up the Print dialog when this report is displayed.

 

 

Main Menu

The main menu is located at the top of the Cash Counter's window:

The following commands are available:



File includes the following submenus:
 

Clear Cash Count (Ctrl+Backspace) - clears all of the cash count fields. This command is also available from a keyboard
shortcut of Ctrl+Backspace.

The Cash Counter will issue a confirmation warning if you incur this command from the main menu and at least one of the cash count fields isn't
empty. Note that the warning isn't issued if you use the keyboard shortcut.
 
Restore Last Cash Count (Ctrl+R) - restores the values of the cash count fields to the last finalized cash count, if one is
available for the currently selected country. This command is also available from a keyboard shortcut of Ctrl+R.

The Cash Counter will issue a confirmation warning if you incur this command from the main menu and at least one of the cash count fields isn't
empty. Note that the warning isn't issued if you use the keyboard shortcut.
 
Done (Ctrl+Enter) - finalizes the cash count, if one is available, and closes the Cash Counter. This command is also
available from a keyboard shortcut of Ctrl+Enter.
 
Exit - closes the Cash Counter without finalizing the cash count. If set up in Preferences, the Cash Counter will memorize
the values of the cash count fields and will restore them the next time you run it.

 
Format includes the following submenus:
 

Currency by Country - allows to switch the layout of the cash count fields to a different country. When clicked, will
present the list of available options:
 

Default - resets the layout of the cash count fields to a default one, that is associated with the regional settings for
your Windows user account. (The Cash Counter starts up with this option by default.)
 
<List of countries> - provides the list of the alphabetized country names currently supported by the Cash Counter.
Picking one will change the layout of the cash count fields in the main window, as well as the numbers, currency
and date formats to the ones specific for a selected country.

The list of available countries is dependent on the subset of languages installed in your Operating System.
 

Hide Rare Denominations - is a toggle switch that is either checked or unchecked. To toggle its state click this item.
When rare denominations are hidden they will not be included in the cash count fields layout, as well as in the Cash
Counting Report.

Rare denominations are specific for each country's currency and can be set up in Preferences.

 
Reports includes the following submenus:
 

Cash Counting Report (Ctrl+P) - allows to print out the Cash Counting Report for the current cash count fields without
finalizing it. This command is also available from a keyboard shortcut of Ctrl+P.
 
Previous Cash Counts (Ctrl+Shift+P) - allows to view and print a report of previous cash counts. This command is also
available from a keyboard shortcut of Ctrl+Shift+P.

The Cash Counter stores up to 1,000 latest Cash Counting Reports by default. This value can be changed in Preferences.

When clicked this command will present a window that will allow you to pick which cash counts you want to view:



The following controls are available:

Range control - provides a preset of the following ranges to use for the search of the previous cash counts: Last 5
counts, Last 10 counts, Last 25 counts, Last 50 counts, Last 100 counts, Today, Yesterday, This week, Last week, This
month, Last month, All counts and Custom date range.
 
From / To controls - in case Custom Date Range is selected in the Range control, let you specify a custom date
range to view the cash counts for.

Both dates in the range must be provided inclusively, meaning that the From and To dates will include cash counts during those dates.
 
Present counts from the latest to the oldest - if checked will present all found cash counts with the latest counts
on top of the printout, otherwise the latest counts will be at the bottom of the printout.
 
OK button - generates the report with requested cash counts.
 
Cancel button - closes this window without producing a report.
 
More Options - opens up additional options for an advanced search:

 
Counted By control - allows you to limit the search for the cash counts done by a specific person.

The name provided in this field is treated as case-insensitive, meaning that names such as "John Doe" and "john doe" will be treated as
equal.
 



Cash drawer amount controls - allow you to limit the search for the cash counts with a specific Cash Drawer
Amount . To use this option fill out the text box on the right with the Cash Drawer amount and provide one of the
following equation criteria in the drop-down box: Equal to, Not equal to, Less than, Less than or equal to, Greater
than, Greater than or equal to.

To understand how these controls are used in the search, picture that we want to limit our search to the cash counts with the Cash
Drawer Amount less than or equal to $200. In this case we would select Less than or equal to in the drop-down control and type in 200 in
the text box. Note that typing the currency symbol (or dollar sign in our case) is not necessary.

In case you leave the text box control on the right empty, this search criterion will not be used for the search. Note that setting it to a 0
will have a different effect - 0 will be interpreted as a 0 amount.
 
Total counted controls - allow you to limit the search for the cash counts with a specific Total Counted amount. To
use this option fill out the text box on the right with the Total Counted amount and provide one of the following
equation criteria in the drop-down box: Equal to, Not equal to, Less than, Less than or equal to, Greater than,
Greater than or equal to.

To understand how these controls are used in the search, picture that we want to limit our search to the cash counts with the Total
Counted amount less than or equal to $200. In this case we would select Less than or equal to in the drop-down control and type in 200
in the text box. Note that typing the currency symbol (or dollar sign in our case) is not necessary.

In case you leave the text box control on the right empty, this search criterion will not be used for the search. Note that setting it to a 0
will have a different effect - 0 will be interpreted as a 0 amount.
 
Petty cash controls - allow you to limit the search for the cash counts with a specific Petty Cash amount. To use
this option fill out the text box on the right with the Petty Cash amount and provide one of the following equation
criteria in the drop-down box: Equal to, Not equal to, Less than, Less than or equal to, Greater than, Greater than or
equal to.

To understand how these controls are used in the search, picture that we want to limit our search to the cash counts with the Petty Cash
amount less than or equal to $200. In this case we would select Less than or equal to in the drop-down control and type in 200 in the text
box. Note that typing the currency symbol (or dollar sign in our case) is not necessary.

In case you leave the text box control on the right empty, this search criterion will not be used for the search. Note that setting it to a 0
will have a different effect - 0 will be interpreted as a 0 amount.
 
Difference controls - allow you to limit the search for the cash counts with a specific Difference amount. To use
this option fill out the text box on the right with the Difference amount and provide one of the following equation
criteria in the drop-down box: Equal to, Not equal to, Less than, Less than or equal to, Greater than, Greater than or
equal to.

To understand how these controls are used in the search, picture that we want to limit our search to the cash counts with the Difference
amount less than or equal to $200. In this case we would select Less than or equal to in the drop-down control and type in 200 in the text
box. Note that typing the currency symbol (or dollar sign in our case) is not necessary.

In case you leave the text box control on the right empty, this search criterion will not be used for the search. Note that setting it to a 0
will have a different effect - 0 will be interpreted as a 0 amount.
 

The Cash Counter uses your web browser to present the results of the requested cash counts. It may look like this:



You may set up in Preferences whether the Cash Counter needs to automatically open up the Print dialog when this report is displayed.

  
Tools includes the following submenus:
 

Add Petty Cash Item (Ctrl+N) - allows to add a new item to the bottom of the Petty Cash list . This command is also
available from a keyboard shortcut of Ctrl+N.
 
Remove Petty Cash Item(s) - allows to remove selected items from the Petty Cash list .

WARNING: Removing Petty Cash list items cannot be undone or reverted!
 
Preferences (Ctrl+K) - displays Preferences window that allows to configure settings for the Cash Counter. This command
is also available from a keyboard shortcut of Ctrl+K.
 

Help includes the following submenus:
 

Online Manual (F1) - opens the online version of this manual. This command is also available from a keyboard shortcut of
F1.

Note that the Internet connection is required for this option to work.
 
Video Tutorial (Alt+F1) - opens the web site with our video tutorial, or screencasts on how to use the Cash Counter. This
command is also available from a keyboard shortcut of Alt+F1 .

Note that the Internet connection is required for this option to work.
 
Check For Updates - opens the web site that allows to check if there's an update available for your version of the Cash
Counter.

Note that the Internet connection is required for this option to work.
In case you would like to receive a notification of an update when it is released, follow us on our Twitter feed.
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How To Uninstall - opens the web site that describes how to uninstall the Cash Counter from your computer.

Note that the Internet connection is required for this option to work.
 
Frequently Asked Questions - opens the web site with answers to the most often asked questions. Please check this
page if you have a question about the Cash Counter before submitting that question to our support team.

Note that the Internet connection is required for this option to work.
 
User Feedback - allows you to connect to our website to leave your comment about this program.

Note that the Internet connection is required for this option to work.
 
Buy Your Copy - (displayed in a demo copy only) allows you to connect to our website to purchase your copy of this
software. The license for a single copy of the Cash Counter costs only 99 cents. All payments are made via a secure
connection through PayPal. Note that your personal and payment information, such as the credit card or a check/bank
number, will be used only at PayPal, and will not be shared with us. This ensures a secure transaction for our customers.

Note that the Internet connection is required for this option to work.
 
Bug Report - opens the web site that allows you to submit a bug report about the Cash Counter.

Note that the Internet connection is required for this option to work.
 
About Cash Counter - displays the window with the information about this program:

Version displays the current version of your copy of the program.
 
Register button (in case of a demo copy) lets you connect to our website to register your copy.

Note that the Internet connection is required for this option to work.
 
System Information provides technical information about the computer the program runs on.

Copy button lets you copy the system technical information to the Windows Clipboard.
 
Registration For This Copy (in case of a purchased copy) provides information about the registration license for
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your copy of the program.
 
Deauthorize button (in case of a purchased copy) let you deauthorize this copy of the Cash Counter. This is
required in case you decide to move your copy of the Cash Counter to another computer. In this case you are
required to deauthorize, or remove the registration license, from the old computer. Note that the Cash Counter
license allows you to register only one copy of the program, and you are required to purchase licenses for every
other copy of the program that you are using.

Deauthorizing your copy of the Cash Counter will remove the registration license and then close the program. Restarting the Cash Counter
from the same Windows user account will most certainly display a message that your copy has expired. In case you decide to reinstall
your copy of the Cash Counter on the same computer you are allowed to re-use the same registration license, provided that you
deauthorized  all other copies of the program.
 

 

Preferences

The Preferences window allows you to customize the Cash Counter's settings. It can be accessed by going to Tools -> Preferences in the
main menu, or by pressing the Ctrl+K keyboard shortcut.

The Preferences window is divided on to the following tabs:

General tab

The following controls are available:

Compact Database - as the message below it suggests, clicking this button will defragment the database file that in turn
will make it smaller in size as well as faster to run. In despite of the benefits of defragmentation, you do not need to worry
much about using this option on a regular basis. We designed the Cash Counter to be both fast and compact and take
care internally of its own database integrity. This option is provided here for those who want to incur the function of
defragmentation manually.
 
Restore cash count on start-up if 'Done' wasn't clicked before - in normal circumstances you would finalize each cash
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count, by clicking the Done button. But in case you close the Cash Counter program before you finalized it, your cash
count may be lost. When this option is checked it will make the Cash Counter preserve the cash count fields in case you
close the program before finalizing it. If you uncheck this option, an un-finalized cash count will be lost in case you close
the Cash Counter.
 
Remember last 'Counted By' user name - if checked will make the Cash Counter memorize a person's name who did the
last cash count, so that when you run the program again the Counted By control will be filled out with their name. Uncheck
this option to make Counted By control to be empty by default when the program starts.
 
When 'Done' is clicked and there's no 'Counted By' name - option allows you to control a situation when user finalizes
the cash count without providing the name of a person who did it in the Counted By control . The following options are
available:

No special action - will make the Cash Counter simply ignore this situation.
 
Flash & Allow to continue - will make the Cash Counter flash the Counted By control with red, and allow to
finalize the cash count after that.
 
Flash & Do not allow to continue - will make the Cash Counter flash the Counted By control with red, and prevent
the cash count from being finalized until a user fills out the Counted By control .

 
Limit cash count fields to N digits - option allows you to specify the size of each of the cash count fields by the number
of digits. (Example: The value of 3 means that a user can enter maximum of 999 as a cash count number.)

The minimum allowed value of digits is 1. The maximum one is 9.
 
'Return' key works as the 'Tab' key in the cash count fields to navigate to the next field - controls the way user can
navigate through the cash count fields using the Enter (or Return) key on the keyboard. When checked will make the Enter
key switch to the next control in the cash count fields . If you uncheck this option, pressing the Enter key will revert to a
default action in Windows, i.e. it will be analogous to clicking the Done button.
 
Skip rare denominations when using keyboard navigation through the cash count fields - when checked will make
the Cash Counter skip all rare denominations when user navigates through the cash count fields using the keyboard (i.e.
Tab, Enter, Up and Down Arrow keys).
 
Automatically print 'Cash Counting Report' when 'Done' is clicked - when checked will make the Cash Counter
produce the Cash Counting Report when user clicks the Done button and finalizes the cash count.

Note that if you uncheck this option the Cash Counter will still finalize each count, but without producing the Cash Counting Report .
 
Automatically pop up Print dialog when displaying pages for printing - in case you prefer to print out the Cash
Counting Report and the Cash Counting History Report produced by the Cash Counter, this option can save you time by
automatically popping up the Print dialog window, that lets you select a printer, when those reports are generated. For
that, check this option.
 
Maximum number of stored cash counts in history - every time you finalize your cash count (by clicking the Done
button) the Cash Counter remembers it in its database for a possible later retrieval through the Previous Cash Counts
option. This setting controls how many cash count reports the Cash Counter is allowed to store in its history. (By default it
stores 1,000 reports.) To change this value, either select it from the drop-down list of predefined values, or simply type in
your number in the text box.

The minimum allowed value of stored cash counts is 1. The maximum one is 999,999.
Note that the Cash Counter uses a very compact form of storing all your previous cash counts, so setting this value high will not jeopardize the
free space available on your hard drive.

The Cash Counter recycles older cash counts in case it reaches the limit of entries set up by this option. Once recycled the cash counts cannot be
restored!

WARNING: Reducing the number of stored cash counts may irreversibly remove older cash counts. If this happens you will not be able to recover
those cash counts!
 
Open 'Previous Cash Counts' selection window with 'More options' displayed - when checked will make the Cash
Counter open the Previous Cash Counts window with the More options enabled. Uncheck this option to display the
Previous Cash Counts window in its compact form.



 
OK button saves changes in all tabs of the Preferences window and applies them to the Cash Counter program.

Note that the changes are applied only when you OK the Preferences window.
 
Cancel button discards all changes done to the settings in the Preferences window since it was opened.

You can also cancel all changes by simply closing the Preferences window with the X button at the top right corner of its window.

 
 
Petty Cash tab

The following controls are available:

Columns section allows to customize the Petty Cash list columns:

Current list contains column names that are currently visible in the Petty Cash list . The order, from top to bottom,
in which they are presented in this list, denotes the order, from left to right, that these columns will appear in the
Petty Cash list .
 
Removed list contains column names of the Petty Cash list that are currently hidden.

Note that hidden columns still retain their data.
 
"<" button allows to move a selected column from the Removed to the bottom of the Current list.
 
">" button allows to move a selected column from the Current to the Removed list, effectively hiding the column.

Note that hidden columns still retain their data.
 
Up button allows to move a selected column in the Current list one entry up (or toward the left side of the actual
Petty Cash list .)
 
Down button allows to move a selected column in the Current list one entry down (or toward the right side of the



actual Petty Cash list .)
 
Reset to Defaults button allows to reset all columns to their predefined defaults.

 
OK button saves changes in all tabs of the Preferences window and applies them to the Cash Counter program.

Note that the changes are applied only when you OK the Preferences window.
Rearranging the Petty Cash list columns also resizes its header columns to their default widths.
 
Cancel button discards all changes done to the settings in the Preferences window since it was opened.

You can also cancel all changes by simply closing the Preferences window with the X button at the top right corner of its window.
 

 
Denominations tab

These settings control the appearance and format of the currency used in the cash count fields. The following controls are
available:

Country selector provides a drop-down list of countries currently available for the Cash Counter. The currency
denominations displayed below are specific for the country selected in this control.

The list of available countries is dependent on the subset of languages installed in your Operating System.
 
Left Column list contains currency denominations that will be displayed in the left column of the cash count fields in the
main window of the Cash Counter for the country selected in the Country control above. The order at which
denominations appear in this list is determined automatically by the amount of each denomination, and will be applied to
the order of these denominations in the cash count fields as well.

Although not rigidly enforced, we intended the denominations in the left column to represent coins, and denominations in the right column to
represent bank notes.
The left column list can be set empty. The only stipulation that the Cash Counter imposes is that you specify at least one non-rare denomination
in either left  or right column list.

You can right-click inside the left column list to get a pop-up menu with similar commands that are available in this window.



 
Right Column list contains currency denominations that will be displayed in the right column of the cash count fields in
the main window of the Cash Counter for the country selected in the Country control above. The order at which
denominations appear in this list is determined automatically by the amount of each denomination, and will be applied to
the order of these denominations in the cash count fields as well.

Although not rigidly enforced, we intended the denominations in the left column to represent coins, and denominations in the right column to
represent bank notes.
The right column list can be set empty. The only stipulation that the Cash Counter imposes is that you specify at least one non-rare denomination
in either left  or right column list.

You can right-click inside the right column list to get a pop-up menu with similar commands that are available in this window.
 
"<" button moves a selected denomination from the right column list to the left column list. The order at which
denominations appear in the left column list is determined automatically by the amount of the denomination. Coins are
also grouped together and appear above the bank notes.

Although not rigidly enforced, we intended the denominations in the left column to represent coins.
The left column list can be set empty. The only stipulation that the Cash Counter imposes is that you specify at least one non-rare denomination
in either left  or right column list.
 
">" button moves a selected denomination from the left column list to the right column list. The order at which
denominations appear in the right column list is determined automatically by the amount of the denomination. Bank notes
are also grouped together and appear below the coins.

Although not rigidly enforced, we intended the denominations in the right column to represent bank notes.
The right column list can be set empty. The only stipulation that the Cash Counter imposes is that you specify at least one non-rare denomination
in either left  or right column list.

 
Selected Denomination section provides controls to edit a denomination currently selected in either left or right column
list.

Note that these controls are disabled if no denomination is selected in either of the lists.

Name text box allows you to edit the name of the currently selected denomination.

There's no restriction on which characters you can use for the name of denomination, although the length of this name cannot exceed 48
characters. Our suggestion is for you to try to keep the name of each denomination as short as possible to preserve the visual layout of
the cash count fields in the main window of the Cash Counter.

If you wish to, the name of a denomination can be left empty. You can also make two or more denominations have identical names.
 
Type control allows to make the currently selected denomination as either a coin or a bank note.

The Cash Counter doesn't make any distinction between coins  and bank notes during cash counting. This distinction was introduced only
for a user convenience. It also allows to specify two denominations with an identical value (by making one a coin and another one a bank
note).
 
Rare amount checkbox allows to specify if the currently selected denomination is a rare one. If checked, the
denomination will be considered as rare. Rare denominations can be treated differently when a user navigates
through the cash count fields using the keyboard. They are also displayed with a grayed out font and a slight
spacer around them in the main window of the Cash Counter. A user can also specify to hide rare denominations
from reports and from the main window of the Cash Counter.

Rare denominations are specific for the currency of each country.
 
Value text box allows to specify the monetary value of the currently selected denomination.

The number format with which you can specify the currency value is defined by the country currently selected in the Country control . For
instance, to specify a 5-cent piece for the U.S. currency, you would type 0.05, but to specify a 5-cent piece for the French currency, you
would type 0,05.

You must provide currency values for each denomination. These values must be represented by positive numbers and cannot be set to
zero. Two or more denominations of the same type (coin or bank note) cannot have identical currency values.

While specifying the currency values for denominations be aware of the rounding that the Cash Counter performs for denominations of
each country. For instance, by default the U.S. currency value cannot be set to less than 0.01. An attempt to set it to, say, 0.005 will round
it up to 0.01that will make this denomination to have the same value as U.S. Pennies. To adjust this rounding behavior, check the Smallest
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available denomination and the Number of fractional digits settings in the Currency format window.

 
"+" button (or Add Denomination command) opens up a window to add a new denomination:

The country displayed in the title of the Add Denomination window will be used for the currency and number formatting in this window.

The controls in this window are similar to the controls explained above for editing a selected denomination.

ADD button will add a new denomination to either left or right column list. Which list depends on how you get to
open the Add Denomination window. If you used the "+" button, the Cash Counter picks the list using the type of a
new denomination - coins are added to the left column list and bank notes to the right column list. You can avoid
this ambiguity if you invoke the Add Denomination command from a pop-up menu after a right-click on either left
or right column list.

The Cash Counter does not perform exhaustive correctness checks while adding new denominations at this stage.
 
Cancel button closes the Add Denomination window without adding a new denomination.

The same effect can be achieved by closing this window with the X button in its top right corner.

 
"-" button (or Remove Denomination command) removes a selected denomination from the list.
 
"..." (More) button provides additional commands:

Reset All Denominations - resets all denominations and currency format to their defaults for the country selected
in the Country control above.

Note that resetting denominations and currency format for the currently selected country has no effect on denominations and currency
formats of other countries.
 
Edit Currency Format - displays the window to allow you to edit the currency format for the country selected in
the Country control above:
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The country displayed in the title of the Currency Format window will be used for the currency and number formatting in this window.

The following controls are available:

Examples fields show the example of a positive currency value (on top), and of a negative currency value
(below) as they would look with the settings in controls below. These fields are updated dynamically as you
change controls in this window.

You can use the Up and Down arrows on the right off of these controls to increase or decrease their values, respectively.
 
Currency symbol - allows to specify the currency symbol for a selected country, such as the $ sign for U.S.
dollar.

Although it is possible to set the currency symbol empty, doing so is not recommended!

Be aware that adding wrong characters, such as numbers, signs or even some letters, to the currency symbol can confuse users as
well as lead to unpredictable results during calculations!

Setting the currency symbol to the same symbol(s) as the decimal symbol or the grouping symbol for thousands is not allowed.
 
Decimal symbol - allows to specify the decimal symbol for a selected country, such as the . (period) in 1.25
for U.S.

The decimal symbol is required and cannot be set empty.

Be aware that adding wrong characters, such as numbers, signs or letters, to the decimal symbol can confuse users as well as lead
to unpredictable results during calculations!

Setting the decimal symbol to the same symbol(s) as the currency symbol or the grouping symbol for thousands is not allowed.
 
Grouping symbol for thousands - allows to specify the grouping symbol for thousands for a selected
country, such as the , (comma) in 1,000 for U.S.

The grouping symbol for thousands can be set empty.

Be aware that adding wrong characters, such as numbers, signs or letters, to the grouping symbol for thousands can confuse users
as well as lead to unpredictable results during calculations!

Setting the grouping symbol for thousands to the same symbol(s) as the currency symbol or the decimal symbol is not allowed.
 
Number of fractional digits - allows to specify the number of digits for the fractional part of the currency
unit for a selected country, such as 2 for the U.S. currency. (You would specify 2 for the U.S. currency
because each unit of its currency, i.e. dollar, is broken down onto 100 cents and each cent value can be



written down as 0.01, and thus 2 fractional digits.)

This setting is used by the Cash Counter to display currency amounts that it works with. For instance, if for U.S. currency this
value is set up as 2 digits, an internal amount of 1.234 will be rounded up to 1.23 due to the fact that only 2 fractional digits were
required. Note that such rounding is done with the Smallest available denomination setting in mind.

This setting goes in tandem with the Smallest available denomination and must be configured appropriately. We had to separate
these two settings due to the fact that currencies of some countries required such adjusted precision.
 
Smallest available denomination - allows to specify the value of the smallest available denomination for a
selected country, such as 0.01 for the U.S. currency. (You would specify 0.01 for the U.S. currency because
each unit of its currency, i.e. dollar, is broken down onto 100 cents. Each cent value is 0.01, that becomes the
smallest available denomination for the U.S. currency.)

You can use the Up and Down arrows on the right off of this control to increase or decrease its value by the factor of 10,
respectively.

The number format with which you can specify this value is defined by a selected country. For instance, to specify 0.01 for the U.S.
currency, you would type 0.01, but to specify the same for the French currency, you would type 0,01.

This setting is used by the Cash Counter to round up currency amounts that it works with. For instance, if for U.S. currency this
value is set up as 0.01, an internal amount of 0.003 will be rounded up to 0.01 due to the fact that the smallest allowed value is
0.01. Note that such rounding is done with the Number of fractional digits setting in mind.

This setting goes in tandem with the Number of fractional digits and must be configured appropriately. We had to separate these
two settings due to the fact that currencies of some countries required such adjusted precision.
 
Positive currency format - allows to specify the format for the positive currency for a selected country.
 
Negative currency format - allows to specify the format for the negative currency for a selected country.
 
Defaults button lets you reset controls in this window to their defaults (effectively resetting the currency
format for a selected country).

This command does not change the currency denominations themselves.

 
OK button saves changes done to controls in this window and closes it.

Note that OK'ing this window saves all changes in a temporary place in the Denominations window of the Preferences. These
changes can still be discarded if the Preferences window is canceled.
 
Cancel discards any changes done to controls in this window and closes it.

The same effect can be achieved by closing this window with the X button in its top right corner.

 
Copy Currency Format - copies the selected currency format along with its technical information onto the
Windows Clipboard as text. Use this option to collect your currency format information for developers of the
program.
 
Send Currency Format To Developers - connects to our web site and fills out the online form with the selected
currency format along with its technical information. Use this method to submit your currency correction to
developers of the program.

Note that the Internet connection is required for this option to work.
 

 

 
OK button saves changes in all tabs of the Preferences window and applies them to the Cash Counter program.

Note that the changes are applied only when you OK the Preferences window.
 
Cancel button discards all changes done to the settings in the Preferences window since it was opened.

You can also cancel all changes by simply closing the Preferences window with the X button at the top right corner of its window.
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Thank you for using the Cash Counter!

We're actively working on improving the Cash Counter software and welcome any feedback from its users.

Feel free to send us your ideas, comments and especially bug reports. Even though we can't answer every single email, we listen and
appreciate your time writing us!

Support Team
www.dennisbabkin.com
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